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阅读提示

符号说明

禁止 重要注意事项 操作、使用提示 词汇解释、参考信息

下载文档

点击以下链接下载最新版用户手册及其他与 Livox Mid 系列激光探测测距仪相关的文档。

www.livoxtech.com/mid-40-and-mid-100

下载 Livox Viewer

通过以下地址下载 Livox Viewer 软件：

www.livoxtech.com/mid-40-and-mid-100

下载 Livox SDK

通过以下地址可获取开源 Livox SDK：
https://github.com/Livox-SDK

 快速搜索关键词

PDF 电子文档可以使用查找功能搜索关键词。例如在 Adobe Reader 中，Windows 用户使用快捷

键 Ctrl+F，Mac 用户使用 Command+F 即可搜索关键词。

 点击目录转跳

用户可以通过目录了解文档的内容结构，点击标题即可跳转到相应页面。

 打印文档

本文档支持高质量打印。
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 产品概述

简 介

Livox Mid-40 和 Livox Mid-100 是一款高性能、安全可靠的激光探测测距仪，可广泛应用于包括无

人驾驶、环境感知、机器人导航、动态路径规划、高精度测绘等众多领域。Livox Mid-40 以及 Livox 
Mid-100 的最大探测距离可达 260 米。

非重复扫描技术：Livox Mid 系列激光探测测距仪（以下简称“Livox Mid 系列”）采用 Livox 自主研

发的非重复扫描技术，可提供更高密度的点云，精确探测视场（FOV）中的每个细节。

高稳定可靠：Livox Mid 系列采用先进的光电系统设计，无需旋转光电发射接收电子器件，在提高性能

的同时，也提升了产品的可靠性。产品均经过规范测试，在 GB 4208-2008（国内）/ IEC 60529（海外）

标准下达到 IP67 防水防尘级别（风扇接口则为 IP55）。

自适应环境：即使在 100 klx 强烈日照干扰下，Livox Mid 系列产品的性能仍不受任何影响。特殊设计

的滤噪算法可有效降低周围其它激光探测测距仪的杂散光干扰。另外，在雨雾等恶劣天气环境下，还

可切换至雨雾模式，降低对雨、雾、和灰尘等大气颗粒的误检几率。

便捷易用的 Livox Viewer 软件：专为 Livox Mid 系列设计的 Livox Viewer 可实时展示三维点云图像并

保存播放点云图像，简洁的界面让操作更轻松。 

开源 Livox SDK：用户可基于 Livox SDK 进行开发，Livox SDK 支持在 Windows/Linux/Mac OS/ROS
环境下使用 C/C++ 等语言开发，进一步满足个性化的应用需求。 

• 当环境温度为 25℃，目标物体的表面反射率为大于等于 80% 时（水泥地或路面的反射率为
15~30%，白色石膏墙的反射率为 90%~99%）测得最大探测距离为 260m。 

• Livox Mid-100 为 Livox Mid-40 的三合一版本， 安装与使用规则基本一致，如无特别指出，本文所
描述的为 Livox Mid-100 和 Livox Mid-40 的通用性能。

• 使用前，请务必移除激光探测测距仪窗口上的保护膜。

产品特性

Livox Mid-40 以及 Livox Mid-100 通过使用非重复扫描技术，具有较高的视场覆盖率，且随着积分时

间的增大，视场覆盖率也会显著增大，探测到视场中的更多细节。

下图所示为不同积分时间内（分别为 0.1s, 0.2s, 0.5s 和 1s）Livox Mid-40 和 Mid-100 的点云图。每

个 Livox Mid-100 的点云图都可以视为由三个 Livox Mid-40 的点云图所组成。

图 1.2.1 Livox Mid-40 不同积分时间内点云效果图

0.1 s 0.2 s 0.5 s 1 s
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下图（图 1.2.3）给出了不同积分时间下 Livox Mid-40 激光探测测距仪的视场覆盖率，和当前市场上

常见的几款多线机械旋转式激光探测测距仪的相关数据。从图中可以看出，当积分时间小于 0.1s 时，

Livox Mid-40 的视场覆盖率性能与某 32 线产品的性能相当；当积分时间增大时，Livox Mid-40 的视

场覆盖率明显提高而某 32 线产品的视场覆盖率保持不变。当积分时间是 0.5s 时，视场覆盖率与某 64
线产品相当；当积分时间继续增大，达到 1.4s 时，视场覆盖率将会接近 100%，即视场中几乎所有区

域都会被激光束照射到。

图 1.2.3 Livox Mid-40 以及当前市场上常见的几种多线机械旋转式激光探测测距仪不同积分时间下的视场覆盖率。其
中，64 线 /32 线 /16 线产品的竖直 FOV 分别是 30° /41° /27°。

视场内激光照射到的区域面积，关系到激光探测测距仪的测量性能。为了表征该指标，可以定量地用
激光探测测距仪视场中被激光探测到的区域的比例，即为视场覆盖率（C）来进行说明。其计算公式为：

查看 Livox 网站了解关于视场覆盖率的更多信息。 

C =
视场内的所有区域面积

被激光光束照射到的区域面积
×100%

视
场
覆
盖
率

 (%
)

积分时间 (s)
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图 1.2.2 Livox Mid-100 不同积分时间内点云效果图

0.2 s
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激光波长 905 nm

安全级别 Class 1 (IEC 60825-1:2014) 人眼安全

量程 (@100 klx) 90 m @ 10% 反射率

130 m @ 20% 反射率

260 m @ 80% 反射率

FOV Livox Mid-40：38.4° （圆形）

Livox Mid-100：98.4°（水平）× 38.4°（竖直）

距离精度 (1σ @ 20m) 2 cm

角度精度 < 0.1°

光束发散角度 0.28° ( 竖直 ) × 0.03° ( 水平 )

数据率 Livox Mid-40：100,000 点 / 秒
Livox Mid-100：300,000 点 / 秒

虚警率 (@100 klx) < 0.01%

表 1.2.1 点云参数

• 当被测物体距离 Livox Mid 系列 小于 1m 时，Livox Mid 系列无法对其进行测量。若您想使用 Livox 
Mid 系列探测 1m 以内的物体或者使用多回波功能，请联系 Livox 公司。

• 环境温度 25℃，目标物体距离 20 m，反射率为 80% 时测得 Livox Mid 系列的距离精度为 2 cm。
具体指标与测试条件相关，以实测结果为准。

部件说明

Livox Mid-40

1

2
3

4

5

1. 窗口
激光光束通过窗口向外发散，从而对 FOV 范
围内的物体进行扫描。 

2. 风扇（入风口）
散热功能。安装时请确保入风口周围 10mm
空间无遮挡。 

3. 安装孔
安装孔为 M3，请选择合适大小的螺丝进行
安装。

4. 激光探测测距仪连接头
使用该连接头连接激光探测测距仪至电源转
接插座。同时用户也可根据该连接头线序进
行配置，激光探测测距仪连接头的线序请查
看接口定义章节。 

5. 出风口
散热功能。安装时请确保入风口周围 10mm
空间无遮挡。 
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1. 激光探测测距仪连接头
使用该连接头连接激光探测测距仪至电源转

接插座。同时用户也可根据该连接头线序进

行配置，激光探测测距仪连接头的线序请查

看接口定义章节。 

2. 风扇（入风口）
散热功能。安装时请确保入风口周围 10mm
空间无遮挡。 

3. M3 安装孔

安装孔为 M3，请选择合适大小的螺丝进行

安装。

1
2

3 5 6
4

4. ¼ 英寸安装孔

适配安装口为 1/4 英寸的平台，如三脚架等。 

5. 出风口

散热功能。安装时请确保入风口周围 10mm
空间无遮挡。 

6. 窗口

激光光束通过窗口向外发射，从而对 FOV 范

围内的物体进行扫描。

Livox Mid-100

电源转接插座

1. 激光探测测距仪连接头接口
连接激光探测测距仪连接头。使用连接器型号
为 JAE MX34012NF1，对应激光探测测距仪连
接头型号为 JAE MX34012SF1。

2. 电源接口
连接至外部电源。使用连接器型号为 MOLEX 
105313-1102，对应线端连接器型号为 MOLEX 
105307-1202。

3. 以太网接口
连接至以太网线。 使用标准 RJ45 以太网接
口。

4. 同步信号口
连接至同步信号线。使用连接器型号为 JST 
SM03B-GHS-TB，对应线端连接器型号为
JST GHR-03V-S。

1

2 3 4
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接口定义

激光探测测距仪连接头接口定义

Livox Mid 系列的连接头及电源延长线的线序及其功能如下，用户不仅可将该接头连接至电源转接插座

的激光探测测距仪连接头接口，更可根据自身需求，使用该连接头进行电源连接、控制信号传输以及

数据传输等。 

图 2-1-1 激光探测测距仪连接接头及电源延长线接头

针 信号 属性 描述

1 Power+ Power DC 10-16V ( 最高 16V)

2 Ground Power Ground

3 Ethernet_TX+ Output 100BASE-TX, TX+

4 Ethernet_TX- Output 100BASE-TX, TX-

5 Ground Power Ground

6 Sync+ Input RS485_A, 秒脉冲

7 Power+ Power DC 10-16V ( 最高 16V)

8 Ground Power Ground

9 Ethernet_RX+ Input 100BASE-TX, RX+

10 Ethernet_RX- Input 100BASE-TX, RX-

11 Ground Power Ground

12 Sync- Input RS485_B, 秒脉冲

表 2-1-1 激光探测测距仪连接头及电源延长线接头线序表

SYNC 信号描述

秒脉冲
(PPS)

t0
t1

t0=1s
1ms<t1<300ms

图 2.1.2 Sync 信号描述

121110987

4321 5 6

* 关于同步信号的详细内容，请查看开发者工具包（SDK）章节。
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针 信号 属性 说明 颜色

1 Power+ Power DC 10-16V( 最高 16V) 红

2 Ground Power Ground 黑

针 信号 属性 说明 颜色

1 Ground Power Ground 黑

2 Sync+ Input RS485_A, 秒脉冲 蓝

3 Sync- Input RS485_B, 秒脉冲 白

电源线及同步信号线接口

Livox Mid 系列线材包中包含一根电源线和一根同步信号线，线序如下：

电源线

A 端接电源转接插座电源接口，B 端用户可外接直流稳压电源。电源线使用连接器型号为

MOLEX105307-1202。

1

500±25 mm

2

A B

表 2.2.1 电源线线序

表 2.2.2 同步信号线线序

同步信号线

A 端接电源转接插座同步信号接口，B 端用户可外接同步信号。同步信号线使用连接器型号为 JST 
GHR-03V-S。查看同步信号章节了解更多信息。

A B500±25 mm

3
1
2

3

1
2

图 2.2.1 同步信号线示意图

图 2.2.1 电源线示意图

以太网接口

为了便于调试，Livox Mid 系列配备的转接插座将连接头转换成了标准的 RJ45 以太网接口。Livox 
Mid 系列支持 100BASE-TX 标准，使用两对双绞线用于发送和接收数据。
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安装

有效视场角（FOV）范围

Livox Mid-40 的 FOV 为 38.4°。Livox Mid-100 作为 Mid-40 的三合一版本，当 Livox Mid-100 将三
个 FOV 为 38.4°的 Livox Mid-40 集成时，部分 FOV 将会重叠，最终获得的水平 FOV 值为 98.4°。
安装 Livox Mid 系列时，请注意 FOV 的有效范围，避免遮挡 FOV 区域。（单位：mm）

45
.7

0

38.4°
19.2°38.4° 19.2°

图 3.1.1 Livox Mid-40 有效 FOV 范围

图 3.1.2 Livox Mid-100 有效 FOV 范围

39
.7

0
19

.2
°

38
.4

°

98.4°

单位 : mm

安装尺寸

Livox Mid-40 尺寸结构

Livox Mid-40 的底部有 4 个深度为 6mm 的 M3 安装孔，可直接安装于目标位置。同时，使用专为
Livox Mid-40 设计的安装底座，可首先通过 M3 安装孔将 Livox Mid-40 安装于安装底座后，再通过安
装底座侧面的多个 M3 螺丝孔，或 1/4 英寸安装孔，将其根据需求固定至合适位置。请根据下图所示
的 Livox Mid-40 尺寸大小及安装孔位尺寸，进行安装。（单位：mm）

69

15.60

45
.7

076

37

4-M3   6

3×4   1.2

8866

54

42

24
20

.3
0

4

1.23

7

16

40.50

图 3.2.1 Livox Mid-40 尺寸结构（大图请查看附录 1）

Table 3-2-1 Livox Mid-40 Weight & Dimensions 

重量 （含线） 760 g

尺寸 88 × 76 × 69 mm

单位 : mm
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单位 : mm

单位 : mm

69

18

44

88

49

44 44

1/4-20
UNC

3-M3   6

3-M3   63-M3   6

图 3.2.2 Livox Mid-40 安装底座尺寸结构（大图请查看附录 2）

重量 101 g

尺寸 88 × 69 × 18 mm

重量 （含线） 2200 g

尺寸 142 × 70 × 230 mm

表 3.2.2 Livox Mid-40 安装底座重量及尺寸

图 3.2.3 Livox Mid-100 尺寸结构（大图请查看附录 3）

表 3.2.3 Livox Mid-100 重量及尺寸

Livox Mid-40 安装底座

Livox Mid-100 尺寸结构

Livox Mid-100 底部有四个深度为6mm的M3 螺丝孔，可通过使用包装内螺丝包中的M3 螺丝进行安装。

此外，底部中央区域还有一个深度为 8mm 的 1/4 英寸安装孔，如需安装至三脚架或其它带 1/4 英寸螺

丝的位置时，可使用该安装孔。请根据下图所示 Livox-100 尺寸大小及安装孔位尺寸，按需求进行安装。

（单位：mm）

39
.7

0
70

0
4

57
70

128
132 6×M3 6

4×5 3

40

214

36

30
°

60
°42

230

4 3
8

14
2

502- 37.50

38 38

30

10
5

12.5

R7.63

1/4-20 UNC
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电源转接插座尺寸结构

如需使用 Livox 电源转接插座，请根据下图所示的电源转接插座尺寸大小及安装孔位尺寸，将其安装

至合适位置。（单位：mm）
52

58

24
.9 32

50
4×M2 5

图 3.2.4 电源转接插座尺寸结构（大图请查看附录 4） 

重量 66 g

尺寸 52 × 58 × 25 mm

表 3.2.4 电源转接插座重量及尺寸

准 备

设计外部电源

Livox Mid 系列支持使用电压为 10 ~16V 的直流电源为其进行供电。通常情况下，Livox Mid-40 的功

率为 10 W， Livox Mid-100 的功率为 30 W。 当设备启动时，在持续的一段时间内存在高峰值功率，

且周围温度越低，峰值功率越高，例如当环境温度为 -20℃，Livox Mid-40 的峰值功率可达 40 W，持

续时间约为 20s，Livox Mid-100 的峰值功率可达 67W，持续时间约为 40s。

使用时请根据 Livox Mid 系列的供电电压范围和峰值功率合理设计外部电源。下图为 Livox Mid 系列峰

值功率和环境温度的关系图。图示值仅供参考，实际使用中，峰值功率会低于图示。 

图 4.1.1 Livox Mid-40 峰值功率与温度关系

-20 -10 40 50 603020100

45

0
5
10
15
20
25
30
35
40

温度 (℃)

功
率

 (W
)

启动时Livox Mid-40的峰值功率

单位 : mm
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图 4.1.2 Livox Mid-100 峰值功率与温度关系

• Livox Mid 的工作环境温度为 -20℃至 65℃，请勿于该温度范围外使用。

• 实际使用中，电压可能会因为外部环境的影响而产生波动。请确保这些波动不会使电压超出 10 ~16V
的范围。

连线

Livox Mid 系列的连接头可提供外部电源，并传输数据。 关于该连接头的具体线序，请查看接口定义

章节内容。使用 Livox Mid 系列激光探测测距仪时，推荐使用 Livox 电源转接插座，Livox 电源转接插

座集成了激光探测测距仪连接头接口、同步信号接口、电源接口以及以太网接口。

Livox Mid 系列通过以太网进行数据通信（UDP），支持两种 IP 地址设置：静态 IP 地址和动态 IP 地址，

出厂时默认采用动态主机配置协议（DHCP）分配 IP 地址。两种 IP 地址设置下连接方式有所不同：1. 
动态 IP（出厂默认，需通过路由器进行连接）；2. 静态 IP（需使用 Livox Viewer 或 SDK 将设备切换

至静态 IP 模式）。Livox Mid-40 与 Livox Mid-100 的连接方式一致，下面以单个 Livox Mid-40 为例进

行说明： 

动态 IP：

图 4.2.1 动态 IP 模式的连接方式
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1. 将 Livox Mid-40 上的激光探测测距仪连接头插入电源转接插座的激光探测测距仪连接头接口。

2. 使用以太网线，分别连接电源转接插座和个人电脑至路由器。请注意，Livox Mid-40 以及个人电脑
的以太网线都接入路由器的 LAN 接口。

3. 通过电源转接插座的电源接口连接外部电源。

4. 将同步信号线一头接入电源转接插座的同步信号接口，另一端连接至同步信号。请注意，仅当需要
使用同步信号时连接同步信号线。 

 多台 Livox Mid-40 可以连接到同一个路由器上，同时与 PC 连接。

静态 IP

1. 首先通过路由器，按照上图（4.2.1）所示的方式连接 Livox Mid-40、电源转接插座、路由器、外部
电源和 PC。 

2. 在电脑上运行 Livox Viewer，于设备属性  中将局域网内激光探测测距仪的 IP 地址设置为静态 IP
地址。请注意，激光探测测距仪的静态 IP 地址应设置为 192.168.1.X 。其中，X 与激光探测测距仪
的广播码有关。若激光探测测距仪的广播码以 1 结尾，则 X 需设置为 11 至 80 之间的任意数字；
若激光探测测距仪的广播码以 2 结尾，则 X 需设置为 81 至 150 之间的任意数字；若激光探测测距
仪的广播码以 3 结尾，则 X 需设置为 151 至 220 之间的任意数字。 

3. 设置完毕后，断开激光探测测距仪的所有连接，注意静态 IP 重启后生效。

4. 然后将电脑设置为静态 IP。电脑的静态 IP 地址应设置为 192.168.1.X（其中，X 为 2~233 之间的
任意数字，并且电脑的静态 IP 地址不可与需要连接的激光探测测距仪的 IP 地址相同）。

连接外部电源

以太网线

图 4.2.2 静态 IP 模式的连接方式

5. 将 Livox Mid-40 上的激光探测测距仪连接头插入电源转接插座。

6. 使用以太网线，连接电源转接插座至个人电脑。

7. 通过电源转接插座的电源接口连接外部电源。

• 若 Livox Mid 激光探测测距仪已被设置为静态 IP 模式，如需再使用路由器进行连接，需先通过 Livox 
Viewer 将激光探测测距仪设置回动态 IP 模式，同时将电脑也设置回动态 IP，再按照动态 IP 部分进行连接。 

•如果需要将多台静态 IP模式的 Livox Mid-40同时与PC连接，请将每台 Livox Mid-40设置成不同的 IP地址，
并且通过交换机与 PC 连接。

• Livox Mid-100 相当于三台 Livox Mid-40，需要设置三个不同的静态 IP 地址。

• 若需要同时连接超过 6 台 Livox Mid-40，请使用千兆路由器或千兆交换机。

• 每台激光探测测距仪的广播码可通过 Livox Viewer 的设备管理器或 SDK 进行查看。Livox Mid-40 的广播码
是其序列号尾部加一个字符“1”，而 Livox Mid-100 的广播码则是三个 Livox Mid-40 的序列号尾部分别加
上字符“1”、“2”或“3”。

• 使用静态 IP 模式时，仅当设置 IP 地址时需要使用路由器，IP 地址设置完毕后无需路由器。 
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使用

坐标系

Livox 激光探测测距仪支持用户使用 Livox Viewer 查看实时点云数据，并通过软件开发工具包（SDK）
对所获取的点云数据进行个性化应用。在了解 Livox Viewer 及 SDK 的详细使用方法前，用户需了解

Livox 激光探测测距仪的直角坐标及球坐标定义如下：

图 5.1.1  Livox Mid-100 坐标定义

图 5.1.2 Livox Mid-40 坐标定义

输出数据

Livox Mid 系列的输出数据中包含了点云数据、时间戳以及状态指示码。

点云数据

点云数据是激光探测测距仪于视场角中于被测物表面所探测到的所有点云的总和。每个点云包含

以下信息。

目标反射率：以 0 至 255 表示。其中 0 至 150 表示漫散射为 0 至 100% 的模型；而 151 至 255
对应反光物体的被测物反射率。当被测物体距离 Livox Mid 系列小于 2.5m 时，目标反射率会默

认为 1。

坐标系：Livox Mid 系列的坐标系可表示为直角坐标系（x, y, z）或球坐标系（r, θ, φ），其直

角坐标和球坐标的对应关系如下图所示。 
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图 5.2.1.1 球坐标与直角坐标关系

时间戳

Livox Mid 支持两种同步方式 :IEEE 1588-2008 以及脉冲同步（PPS）。

IEEE 1588-2008：IEEE 1588-2008 是指“Precision Time Protocol”即“精确时间协议”，通过以太

网对测量以及系统控制实现精确的时钟同步。Livox 激光测距探测仪，作为 PTP 中的普通时钟，仅支

持 UDP/IPV4。Livox 激光探测测距仪支持以下报文格式：Sync、Follow_up、Delay_req 以及 Delay_
resp. 

PPS：脉冲同步通过同步信号线实现数据同步。查看接口定义章节了解更多信息。其同步逻辑如下图

所示。脉冲同步的脉冲周期为 t0（t0=1 s）, 高电平时间 t1 （1 ms <t1<300 ms）。脉冲同步上升沿到

来时，点云中时间戳清零，因此点云数据的时间戳表示的是点云数据采样与上一个脉冲同步上升沿的

间隔时间。

秒脉冲
(PPS)

t0
t1

t0=1s
1ms<t1<300ms

图 5.2.2.1 脉冲同步

状态指示

状态指示代码显示当前Livox Mid系列的工作状态。通过状态指示代码，用户可查看温度状态、电压状态、

电机状态、脏污预警、剩余工作寿命以及脉冲同步信号状态。用户可于 Livox Viewer 或 SDK 中查看状

态指示代码。查看 Livox Viewer 章节设备管理窗口部分了解如何查看状态指示代码。 
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状态 描述

温度状态 提示是否温度异常。温度状态包括：正常、警告和错误。 

电压状态 提示是否出现内部电压异常。电压状态包括：正常、警告和错误。

电机状态 提示是否出现内部电机异常。电机状态包括：正常、警告和错误。

脏污警告 提示是否于窗口检测到严重的灰尘，以及是否有物体遮挡窗口或是否距离激

光探测测距仪近处有障碍物。

剩余工作寿命警告 提示是否当前激光探测测距仪已临近其使用寿命。当该预警出现时，激光探

测测距仪还能使用一段时间，请及时更换。

脉冲同步信号状态 提示脉冲同步信号是否正常接入。  

工作状态 描述

初始化状态 激光探测测距仪正在启动。

正常工作状态 激光探测测距仪已经启动，且正常工作。

待机状态 激光探测测距仪已经启动，但还未发射激光光束。

低功耗状态 除通信模块外，其他部分已停止工作。 

错误状态 检测到错误后，激光探测测距仪将会进入错误状态。除通信模块外，其余部分将

会关闭。

工作状态及工作模式

Livox Mid 系列工作状态包括初始化状态、正常工作状态、待机状态、低功耗状态以及错误状态。

图 5.2.1 不同工作状态的关系示意

低功耗状态

初始化状态

错误状态

待机状态正常工作状态
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图 5.2.2 Livox Viewer 中可设置的不同工作模式之间的关系

Livox Mid 系列有三种工作模式：正常工作模式、待机模式以及低功耗模式。用户可前往 Livox Viewer
或 SDK 设置不同的工作模式。 

雨雾模式

当于恶劣天气环境下使用 Livox Mid 系列时，激光探测测距仪可能会误将大气颗粒，例如雨、雾或灰

尘识别为目标物体。而 Livox Mid 系列的雨雾模式可于恶劣天气坏境中降低对大气颗粒的误检测率。 

0

amp.

时间 时间

0

amp.

a. 未使用雨雾模式 b. 使用雨雾模式

大气颗粒大气颗粒

图 5.4.1 使用 / 未使用雨雾模式时错误检测的对比

请注意，雨雾模式仅能降低对雨、雾或灰尘的误测率。但雨雾模式可能也导致 Livox Mid 系列降低对

某些低反射率的物体表面的检测率，如玻璃或电线。仅当必要情况下开启雨雾模式。用户可于 SDK 中

开启雨雾模式，请查看 Livox SDK 通信协议文档了解更多信息。 

Livox Viewer

Livox Viewer 是一款专为 Livox 激光探测测距仪和 Livox Hub 设计的，可用于实时显示连接至计算机

的所有激光探测测距仪点云数据的软件。通过 Livox Viewer，用户可轻松查看、记录并存储点云数据，

以便后期使用。 

前往 www.livox.com 下载最新版本的 Livox Viewer。Livox Viewer当前支持Windows 7/8/10 （64位）

以及 Ubuntu 16.04 （64 位），请按照以下步骤使用 Livox Viewer。

• 在 Windows 系统下使用 Livox Viewer 时，由于操作系统的防火墙对网络数据的拦截，可能导致 Livox 
Viewer 无法扫描到 LiDAR。若出现此情况，请用户在电脑控制面板中关闭防火墙，然后再重启 Livox 
Viewer。使用前请注意显卡驱动已正确安装，若显卡驱动安装不正确，可能导致 Livox Viewer 无法打
开或者程序崩溃。

低功耗模式

待机模式正常工作模式
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Windows 用户： 解压文件，并于已解压的文件中打开文件名为 Livox Viewer 的程序。

Ubuntu 用户：需要在解压缩后文件的根目录下启动终端（或者直接启动终端后进入到解压缩后文件夹

的根目录），运行指令：./livox_viewer.sh 即可启动。

Livox Viewer 主页界面

图 5.1.1 Livox Viewer 主页界面

File: 点击“Open->Open File”可以打开一个以 LVX 格式储存的点云文件；点击“Open->Open 
Device Manager”将会打开设备管理器，用来扫描和连接在线设备；点击“Save as->.las file”可以

将当前主界面下的点云储存为 LAS 格式文件；点击“Save as->.csv file”可以将当前主界面下的点云

储存为 CSV 格式文件；点击“Clear”将清空主界面下的点云；

Tools：点击“Grid propriety”，可设置网格坐标的样式、颜色、以及显示范围；点击“Firmware 
Update”可查看当前激光探测测距仪，Livox Hub的固件版本号，下载并升级最新固件；点击“Extrinsic 
Calibration”, 可导入外部参数；电机“Options”可选择录制的点云数据文件的存储路径；点击“Lvx 
to Las Tool”允许用户将 Lvx 格式点云文件转换为 Las 文件，请注意该工具的转换方式是将一个 Lvx
文件转内所有帧的点云转换为一个 Las 文件，转换后的 Las 文件只有一张点云图，暂时不支持将 Lvx
文件按帧为单位转存。Net Adapter：选择网络。

Help：查看帮助。 

 : 打开已保存的 Lvx 格式点云数据文件。

：打开激设备管理窗口，搜索局域网内的所有 Livox 激光探测测距仪和 Livox Hub。 

 ：点击当播放录制的点云数据图像时，打开 Lvx 管理器。

 ：显示 / 隐藏所框选区域点云的相关数据，然后选择某个区域，以查看该区域点云数据的详细信息。

：显示 / 隐藏网格坐标。Livox Viewer 中的网格坐标默认是由 13 个从圆心散开的圆形组成。中间 10
个圆形距离相等，显示的是距离激光探测测距仪模块 10m~100m 范围内所测到的物体。11 至 13 个圆

形分别表示距离激光探测测距仪模块 150m，200m 以及 300m 范围内的物体。 

 ：重置点云界面，缩放以于 Livox Viewer 显示所有点云图像。  
：选择所查看的点云数据视角，分别为右视图、正视图、俯视图以及后视图。除点击图标

切换视图外，用户还可通过以下方式切换点云视图：

a. 滑动鼠标滚轮放大 / 缩小视图；

b. 按住鼠标左键的同时，移动鼠标可调整视图 ;

c. 按下 “ctrl”按键，并按住鼠标左键，此时移动鼠标可旋转点云视图；
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d. 按下 “shift”，并按住鼠标左键，此时移动鼠标可调整点云位置。 

: 显示或隐藏颜色指示条。颜色指示条可作为点云数据的参考。用户可设置根据色深或反射率来显示
颜色指示条。

Color: reflectivity   ：设置点云着色方案，可按照反射率、激光探测测距仪 ID 设置点云颜色，同时也可选择

设置点云为固定默认色（默认按照反射率对点云进行着色）。

Point Size 1px  ：设置点云大小，可选择：1px, 2px, 3px, 4px 和 5px。
Coordinate Cartesian   ：选择原始点云数据格式类型为直角坐标或球坐标。

 播放按钮，功能如下：

  ：回到开始。（查看实时点云图像时，该按钮不可用）

  ：进入片尾。（查看实时点云图像时，该按钮不可用）

 ：退后 1 帧。（查看实时点云图像时，该按钮不可用）

 ：前进 1 帧。（查看实时点云图像时，该按钮不可用）

 ：播放 / 暂停。

 ：录制。当一个或多个激光探测测距仪成功连接后，可点击  录制按钮开始录制，再次点击停止

录制。 
Frame Time 100ms ：帧时间：可设置：50、100、200、500、1000、3000ms，选择的帧时间越长，所能看

到的点云图越密集。推荐选择 1000ms。 
Playback Speed 4.0x  ：播放速度。可设置： x0.5, x1.0, x2.0 以及 x4.0（查看实时点云图像时，该功能不可设置）。

00:00:00/00:00:00 ：进度条：显示当前帧。用户可拖动进度条查看所需帧。（查看实时点云图像时，进

度条不可拖动）。

设备管理窗口

图 5.1.2 Livox Viewer 设备管理窗口

 : 连接所有设备。

 : 断开所有设备。

 : 显示所有已连接激光探测测距仪的点云数据。

 : 隐藏所有已连接激光探测测距仪的点云数据。
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1LVDFBC00401731 Mid-40

1LVDFBC00401732 Mid-40

1LVDFBC00401733 Mid-40

 ：显示局域网内所选设备类别下的所有设备。

 : 查看工作模式，或错误模式下的错误码。

 : 显示或隐藏所选择的激光探测测距仪的点云图像。

 : 滑动可连接或断开所选择的激光探测测距仪。

查看实时点云图像

1. 正确连接 Livox 激光探测测距仪或 Livox Hub，然后打开 Livox Viewer。点击 ， 将会弹出设备管
理窗口。管理窗口中将会自动显示局域网内的所有设备。

2. 于管理窗口上方勾选 LiDAR。
3. 选择需要查看的设备，点击图标  完成连接。或选择需要查看的设备后，单击鼠标右键，选择

Connect 完成连接。同时，用户也可直接点击  连接局域网内的所有设备。

4. 连接完成后，点击开始播放图标 ，即可观察到所选设备的点云图像。

录制点云图像

当一个或多个激光探测测距仪成功连接后，可点击录制按钮 ，再次点击  停止录制。

播放存储的点云图像

点击  或通过通过 File>Open file 打开已保存的 Lvx 格式点云数据文件。播放存储的点云数据文件时，
可通过使用播放按钮设置播放速度。 查看存储的点云图像时，可点击主页的  显示 Lvx 管理窗口。点

击  隐藏或显示所选择的激光探测测距仪点云。

外部参数标定

Livox Mid-100 是 Livox Mid-40 的三合一版本，在出厂时，Livox Mid-100 已经经过标定，无需对单一
的 Livox Mid-100 再次进行外部参数标定操作。其余情况下，若用户有外部参数标定需求，请按照以
下方式进行操作：

点击 Tools>External Param Tool, 可进入外部参数标定页面。
外部参数格式需满足以下要求：

其中，“1LVDFBC00401731”表示激光探测测距仪的广播码。点击右上角“Start Cali”可查看当前
所有成功连接设备的坐标信息，用户可选择于表格中逐一手动输入数字：

注意，上述两个图标   只是关闭或开启 Viewer 本身对点云的显示，并不会关闭或者启动设备的采

样功能。

 设备属性，可查看设备类型、当前固件、当前工作模式等，并且可设置单个设备的工作模式，设置

静态或动态 IP。 
Lidar Hub  选择需查看的设备类别。
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或使用下面的调节拨盘对坐标信息进行调整。使用调节拨盘时，支持按住“Ctrl”的同时选择表格纵向
上的多个数据进行同步更改。

选择 Load from file 可快速导入外部参数。

选择 Read from device 可读取当前设备的坐标信息，当前激光探测测距仪具有储存外参功能，但该外
参不会对激光探测测距仪输出的点云数据造成影响，仅为储存功能，详情请参考 SDK 通讯协议文档。

选择 Save param as 可将当前所设置的设备的坐标信息导出进行存储。

选择 Apply 将新的设置应用于当前设备，可选择是否将当前外参写入激光探测测距仪。选择写入时参
数才会对本地生效，如果点否，则不进行任何形式的修改。

• 通过手动输入数字，或使用调整图标来改变设备的坐标位置后，需点击 Apply 才可将新的坐标位置应用
于设备上。 

• 查看 SDK 通讯协议文档，了解关于外部参数标定的更多详细信息。 

下载固件时，请确保计算机可接入互联网。固件下载完毕后，升级过程中，无需互联网连接。

切换点云图视角

点击下面的图标切换点云图视角，分别可切换至：

 

右视图         前视图         俯视图         后视图

同时也可通过：

(a) 滑动鼠标滚轮放大 / 缩小视图。

(b) 按住鼠标左键的同时，移动鼠标可调整视图。

(c) 按下 “ctrl”按键，并按住鼠标左键，此时移动鼠标可旋转点云视图。

(d) 按下 “shift”，并按住鼠标左键，此时移动鼠标可调整点云位置。

固件升级

用户可使用 Livox Viewer 检查并升级 Livox 激光探测测距仪及 Livox Hub 的固件，具体方法如下：

1. 点击 Tools>Firmware Update, 此时将会弹出固件升级窗口，并显示所有已连接的设备。

2. 于 Update Mode 中选择 Lidar Update，然后将会显示相应设备。

3. 于 Firmware Download 下方点击 Check Firmware 检查设备的当前固件版本。

4. 于 Firmware Version 中选择所需下载的固件版本，然后点击 Download 下载。 
5. 下载完成后，于 Firmware Update 下方选择所需升级的设备，然后点击…导入刚才所下载的固件。

6. 点击 Start 更新设备固件。

7. 更新完成后，设备将会自动重启并自动重新连接至计算机，若更新失败，请再次尝试。
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软件开发工具包

除使用 Livox Viewer 查看实时点云数据外，用户还可使用软件开发工具包（SDK）将通过 Livox 激光

探测测距仪所获取的点云数据应用于各自定义场景。

SDK 通讯协议

用户与 Livox 激光探测测距仪之间可通过两种类型的通信协议进行交互，这两种通信协议的数据类型

不同。具体功能和区别如下 :

控制命令数据：激光探测测距仪参数以及状态信息配置及查询。

点云数据：激光探测测距仪生成的点云坐标数据。

两种通信协议都位于 UDP 包中的数据区域，以小字节格式进行存储。

访问 http://www.livoxtech.com/sdk查看关于SDK通讯协议以及Livox SDK API文档的更多详细信息。 

存储、运输与保养

存 储

Livox Mid 系列的存储温度为 -40 ℃ ~85℃，请将其存储于干燥无尘的环境中，并注意：

• 严禁将产品暴露在有毒有害及腐蚀性的环境中。 
• 保存时轻拿轻放，切勿摔落产品。 
• 对于超过三个月保存期的，请定期检查外观与接口，避免使用时出现异常。 

运 输

运输前，请仔细检查产品是否已牢固安装到位，确认无误后将产品装入包装箱。 

包装箱中务必放入缓冲泡棉，并保证包装箱内干燥清洁，无水汽。

运输过程中请务必小心轻放，切勿磕碰、撞击或摔落产品。

保 养

Livox Mid 系列在设计中充分考虑了可靠性和稳定性的要求，具有先进的光学、机械以及电气性能。正

常使用下故障概率较小，仅需对激光探测测距仪窗口进行清洁。

若激光探测测距仪窗口无污点或灰尘等杂质，无需对其清洁。由于污点或灰尘等杂质会影响激光探测

测距仪的性能，因此，若发现窗口上有污点等杂质，请按照以下步骤进行清洁：

1. 使用压缩空气清洁器：
使用镜头清洁布擦拭窗口前，请首先使用压缩空气清洁器对准窗口需清洁的部分进行点喷。注意：
当窗口上有颗粒状的灰尘等杂质时，直接擦拭窗口可能会导致激光探测测距仪损坏。

2. 擦拭污点
使用用酒精湿润的镜头清洁布擦拭窗口，使用干的镜头清洁布可能会损坏窗口。擦拭时，请注意小
心用力，然后轻轻将污点擦拭干净。

如果窗口仍然存在污点，请使用温和的肥皂溶液轻轻地清洗窗口。然后重复步骤 2 去除肥皂残留物。
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疑难解答
使用中若出现任何问题，请查看下表获取解决方案，若依旧无法解决，请联系 Livox 或 Livox 授权的经

销商。 

问题 解决方案

无法检测到 Livox 激光探测

测距仪

• 确认是否所有线材已正确连接。

• 确认电压正确，Livox 激光探测测距仪的工作电压为 10 ~ 16V。确认

电源额定功率大于 60W。

• 确认 Livox 激光探测测距仪未连接至其他软件。

• 确认设备与上机位连接至同一局域网。

• 确认未安装杀毒软件等屏蔽以太网广播的软件。

以上确认完毕后，若还无法检测到 Livox 激光探测测距仪，请关闭所有

的防火墙并再次搜索局域网内的激光探测测距仪。

请使用网络封包分析软件对输出的数据进行分析（例如 Wireshark）

能检测到 Livox 激光探测测

距仪，但无法建立连接 / 或
无法开始采样

• 确认是否所有线材已正确连接。

• 确认电流电压合理，Livox 激光探测测距仪的工作电压为 10 ~ 16V。
电源额定功率大于 60W。

若问题依旧存在，请重启激光探测测距仪以及 Livox Viewer 软件。

无数据 请使用网络封包分析软件对输出的数据进行分析（例如 Wireshark）。

售后保修信息
前往 www.livoxtech.com/support 了解更多关于 Livox 激光探测测距仪的保修信息。 
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附 录

附录一

Livox Mid-40 尺寸结构 （单位：mm）
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附录三

Livox Mid-100 尺寸结构（单位：mm）
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附录二

Livox Mid-40 安装底座尺寸结构（单位：mm）
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附录四

电源转接插座结构尺寸（单位：mm）
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Livox Mid-40/ Livox Mid-100
工作温度 -20 ˚C 至 65 ˚C
激光波长 905 nm
激光安全 Class 1 (IEC 60825-1:2014) 人眼安全

量程 (@100 klx)
90 m @ 10% 反射率
130 m @ 20% 反射率
260 m @ 80% 反射率

FOV Livox Mid-40 : 38.4° 圆形
Livox Mid-100：38.4° ( 竖直 ) × 98.4° ( 水平 )

距离精度 (1σ @ 20 m) 2 cm
角度精度 < 0.1 º
光束发散角度 0.28° ( 竖直 ) × 0.03° ( 水平 )
数据率 Livox Mid-40：100,000 点 / 秒；Livox Mid-100:300,000 点 / 秒
数据延迟 ≤ 2 ms
虚警率 (@100 klx) < 0.01%
防护级别 IP67（除风扇）

功率
Livox Mid-40：10 W（平均）40 W（峰值）

Livox Mid-100：30 W（平均）67 W（峰值）

供电电压范围 10 ~16 V DC

尺寸
Livox Mid-40: 88×69×76 mm
Livox Mid-100: 142×70×230 mm

重量
Livox Mid-40: 760 g
Livox Mid-100: 2200 g

Livox Mid-40 安装底座

尺寸 88×69×18 mm

参数
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重量 101 g
电源转接插座

尺寸 52×58×25 mm
重量 66 g



Livox 和 Livox Mid 是香港览沃科技有限公司的商标。

Windows 是美国微软公司及其子公司的注册商标。


